BAB Il
METODE PENELITIAN

Suatu cara untuk mencari, mengumpulkan, mendapatkan, mencatat data,
baik primer maupun sekunder yang dapat digunakan untuk keperluan menyusun
karya ilmiah dan kemudian menganalisis faktor-faktor yang berhubungan dengan
pokok permasalahan sehingga akan didapat suatu kebenaran atau data yang
diperoleh merupakan metode penelitian. Menurut Sugiyono (2017, him. 3), secara
umum metode penelitian diartikan sebagai cara ilmiah untuk mendapatkan data
dengan tujuan dan kegunaan tertentu.

Jenis penelitian yang digunakan adalah penelitian kuantitatif. Menurut John
W. Creswell (2013, him. 3) metode penelitian kuantitatif adalah pendekatan untuk
menguji teori obyektif dengan memeriksa hubungan antar variabel. Variabel-
variabel ini, pada gilirannya, dapat diukur, biasanya pada instrumen, sehingga data
bernomor dapat dianalisis menggunakan prosedur statistik.

Sedangkan menurut Sugiyono (2017, him. 13) metode penelitian kuantitatif
adalah:

Metode penelitian kuantitatif dapat diartikan sebagai metode penelitian

yang berlandasan pada filsafat positivisme, digunakan untuk meneliti pada

populasi atau sampel tertentu, pengumpulan data menggunakan instrumen

penelitian, analisis data bersifat kuantitatif/statistik, dengan tujuan untuk

menguji hipotesis yang telah ditetapkan.

Dari pemaparan tersebut, penulis menyimpulkan bahwa metode penelitian
berkaitan dengan prosedur, alat, serta desain penelitian yang digunakan, untuk
mendapatkan tujuan yang diinginkan sehingga dihasilkan penelitian yang
benarbenar ilmiah atas permasalahan-permasalahan penelitian.

Terdapat banyak jenis metode penelitian yang dapat digunakan sesuai
dengan penelitian yang akan dilakukan, dalam penelitian ini penulis menggunakan
metode penelitian korelasional. Menurut Sudjana dan lbrohim (2007, him. 77),
“studi korelasi mempelajari hubungan dua variabel atau lebih, yakni sejauh mana

variasi dalam satu variabel berhubungan dengan variasi dalam variabel lain”.
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Sedangkan menurut Gay dalam Sukardi, (2004, him. 166), bahwa
“penelitian korelasi merupakan salah satu bagian penelitian ex-postfacto karena
biasanya penelitian tidak memanipulasi keadaan variabel yang ada dan langsung
mencari keberadaan hubungan dan tingkat hubungan variabel yang direfleksikan
dalam koefisien korelasi.”

Dari pemaparan di atas, penulis menarik kesimpulan bahwa penelitian
korelasi merupakan salah satu bagian dari penelitian ex-postfacto yang bertujuan
untuk mengetahui hubungan antara dua variabel atau lebih. Harapannya dengan
penggunaan metode ini dapat mengungkap hubungan antara jenis kelamin, status
gizi, dan aktifitas fisik dengan kebugaran jasmani siswa SMK Wikrama 1 Garut.
3.1  Desain Penelitian

Penelitian ini merupakan penelitian korelasional yang bertujuan untuk
mengetahui hubungan jenis kelamin, status gizi dan aktivitas fisik dengan
kebugaran jasmani siswa SMK Wikrama 1 Garut tahun ajaran 2020/2021. Pada
penelitian ini subjek yang digunakan adalah siswa SMK Wikrama 1 Garut tahun
ajaran 2020/2021. Desain penelitian yang disajikan adalah sebagai berikut
sebagai berikut:

Gambar 3.1. Paradigma Penelitian

X1 7
r2
X2 %
>
X3
Keterangan :
X1 = Jenis Kelamin
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X2 = Status Gizi

X3 = Aktifitas Fisik

Y = Kebugaran Jasmani

rX1Y = Hubungan Jenis Kelamin dengan Kebugaran Jasmani

rX2Y = Hubungan status Gizi dengan Kebugaran Jasmani

rXsY = Hubungan Aktifitas Fisik dengan Kebugaran Jasmani

rX123Y = Hubungan Jenis Kelamin, Status Gizi, dan Aktifitas Fisik dengan

Kebugaran Jasmani

3.2 Definisi Operasional Variabel

Untuk mencapai tujuan dari penelitian ini perlu diketahui terlebih dahulu
variabel penelitiannya. Variabel yang ada dalam penelitian ini ada 3 yaitu
variabel bebasnya jenis kelamin, status gizi dan aktifitas fisik siswa, variabel
terikat yaitu kebugaran jasmani siswa.
3.2.1 Jenis Kelamin

American Psychological Association (APA 2011) mengemukakan bahwa
Jenis kelamin "mengacu pada status biologis seseorang” dan dapat diidentifikasi
dengan "kromosom, organ reproduksi internal, dan genitalia eksternal” sedangkan
gender mengacu pada "sikap, perasaan , dan perilaku yang diasosiasikan budaya
tertentu dengan jenis kelamin biologis seseorang” yang di kutip oleh(Leavy, n.d.).
3.2.2 Status Gizi

Menurut Supariasa et al., (2016) status gizi adalah ekspresi dari keadaan
keseimbangan dalam bentuk variabel tertentu, atau perwujudan dari nutriture
dalam bentuk variabel tertentu. Status gizi seseorang erat kaitannya dengan berat
badan, menurut WHO. Indikator variabel status gizi pada penelitian ini adalah gizi
baik, buruk dan kurang. Data diperoleh dari penilaian BMI kepada siswa SMK
Wikrama 1 Garut.
3.2.3 Aktivitas Fisik

WHO mendefinisikan aktivitas fisik sebagai setiap gerakan tubuh yang
dihasilkan oleh otot rangka yang membutuhkan pengeluaran energi - termasuk
aktivitas yang dilakukan saat bekerja, bermain, melakukan pekerjaan rumah tangga,
bepergian, dan melakukan kegiatan rekreasi. Sementara itu pendapat lain

mengemukakan, Aktivitas fisik terdiri dari setiap gerakan tubuh yang dihasilkan
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oleh otot rangka yang menghasilkan peningkatan laju metabolisme dibandingkan
pengeluaran energi istirahat (Claude Bouchard, Steven N. Blair, 2012).
3.2.4 Kebugaran Jasmani
Kebugaran jasmani adalah derajat sehat dinamis seseorang yang menjadi
kemampuan dasar untuk dapat melaksanakan tugas yang harus di laksanakan
(Santosa Giriwijoyo 2017 : 60). Sementara itu pendapat lain mengemukakan
bahwa kebugaran jasmani dapat didefinisikan sebagai seperangkat atribut yang
dimiliki atau dicapai orang yang berkaitan dengan kemampuan untuk melakukan
aktivitas fisik (Caspersen et al.,) dan karakteristik ini dianggap sebagai indikator
kuat kesehatan pada masa kanak-kanak dan remaja ( Ortega et al.,) yang di kutip
oleh (Liao et al., 2014).
3.3  Partisipan
Partisipan merupakan salah satu bagian dalam penelitian yang dapat penulis
tentukan karena beberapa kriteria tertentu yang sesuai untuk penelitiannya, seperti
kekhususan dan tujuan tertentu, Kkarakteristik, atau keterbatasan kemampuan
peneliti. Karena tujuan dan karakteristik tertentu, maka partisipan dalam penelitian
ini yaitu siswa SMK Wikram al Garut. Pemilihan siswa SMK Wikrama 1 Garut ini
dianggap akan sangat membantu peneliti dan mempermudah proses penelitian,
seperti proses koordinasi, perizinan, penentuan sampel, dan lain-lain. Beberapa
alasan peneliti memilih atau menentukan siswa SMK Wikramal Garut ini sebagai
partisipan adalah sebagai berikut:
1) SMK Wikrama 1 Garut merupakan salah satu sekolah swasta favorit di Kab
Garut di buktikan dengan banyaknya siswa yang bersekolah di SMK ini.
2) SMK Wikrama 1 Garut merupakan sekolah dengan berbagai kearifan lokal
dan keunikan tersendiri.
3) Siswa SMK Wikrama 1 Garut terdiri dari berbagai lapisan masyarakat dari
mulai warga dengan penghasilan rendah, menengah dan berkecukupan.
4) Sekolah dengan prestasi akademik dan non akademik yang cukup baik.
Beberapa alasan tersebut di atas menjadi dasar pertimbangan dari
penentuan partisipan (populasi dan sampel) dalam penelitian ini. Kiranya
pertimbangan pertimbangan tersebut dapat menjadi maklum tanpa

Arga Firdaus, 2021

HUBUNGAN JENIS KELAMIN, STATUS GIZI DAN AKTIFITAS FISIK DENGAN KEBUGARAN JASMANI SISWA
SMK WIKRAMA 1 GARUT

Universitas Pendidikan Indonesia repository.upi.edu perpustakaan.upi.edu



32

mengurangi esensi dari penelitiannya itu sendiri, sehingga dengan
ditetapkannya partisipan penelitian ini diharapkan dapat memperlancar

proses penelitian.

3.4 Populasi dan Sampel
Menurut Suharsimi Arikunto (2014:173), “Populasi adalah keseluruhan
subjek penelitian”. Populasi dalam penelitian ini adalah seluruh siswa SMK
Wikrama 1 Garut tahun ajaran 2020/2021 yang berjumlah 307 siswa. Dalam
penelitian ini seluruh populasi dijadikan sebagai sampel penelitian.
Adapun perincian jumlah populasi dalam penelitian ini adalah sebagai

berikut:
Tabel 3.1 Populasi siswa SMK Wikrama 1 Garut
No. Kelas Jumlah siswa
1 X 87
2 X1 126
3 Xl 94
Jumlah 307

Sumber data: tata usaha SMK Wikrama 1 Garut
Berdasarkan pengertian di atas, penulis memahami bahwa populasi bukan
hanya sekedar jumlah yang ada pada obyek atau subyek yang dipelajari, tetapi
meliputi seluruh karakteristik atau sifat yang dimiliki oleh objek atau subjek
tersebut. Sedangkan sampel terdiri atas sejumlah anggota yang dipilih dari populasi
yang secara acak dari keseluruhan siswa smk Wikrama 1 Garut. Sampel adalah
subkelompok atau sebagian dari populasi.
Dengan meneleti sampel, maka peneliti akan mampu menarik kesimpulan
yang dapat digeneralisasikan terhadap populasi penelitian. Sugiyono (2017:81)
sampel adalah bagian dari jumlah dan karakteristik yang dimiliki oleh populasi.
Sampel dilakukan karena peneliti memiliki keterbatasan dalam melakukan
penelitian baik dari segi waktu, tenaga, dana dan jumlah populasi yang sangat
banyak. Maka peneliti harus mengambil sampel yang benar-benar representatif
(dapat mewakili). Pengambilan sampel terdiri dari memilih beberapa bagian dari
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populasi untuk diamati sehingga seseorang dapat memperkirakan sesuatu tentang
seluruh populasi.(Thompson, 2012) Berdasarkan pengertian tersebut, maka dapat
disimpulkan bahwa sampel merupakan sebagian atau wakil dari jumlah dan
karakteristik yang dimiliki oleh populasi yang diteliti. Selanjutnya, teknik atau cara
penentuan sampel untuk penelitian.

Teknik sampling dapat diartikan sebagai suatu cara untuk mengumpulkan
data yang sifatnya tidak menyeluruh yaitu mencakup seluruh objek penelitian
(populasi) tetapi hanya sebagian dari populasi saja. Menurut Sugiyono (2017, him.
81) “Teknik sampling adalah teknik pengambilan sampel. Untuk menentukan
sampel dalam penelitian, terdapat berbagai teknik sampling yang digunakan”.
dalam penelitian, terdapat berbagai teknik sampling yang digunakan”. Teknik
sampling pada dasarnya dikelompokkan menjadi dua yaitu Probability Sampling
dan Non Probability Sampling. Dalam penelitian ini penulis menggunakan teknik
Probablity Sampling. Menurut Sugiyono (2017: 82) "Probability Sampling adalah
teknik pengambilan sampel yang memberikan peluang yang sama bagi setiap unsur
(anggota) populasi untuk dipilih menjadi angota sampel.”

Jenis Probability Sampling pada penelitian ini adalah Simpel Random
Sampling. Simple Random Sampling adalah pengambilan anggota sampel dari
populasi yang dilakukan secara acak tanpa memperhatikan strata yang ada dalam
populasi itu menurut (Sugiyono 2017:82).. Alasan pemilihan sampel menggunakan
Simple Random Sampling adalah karena semua siswa memilik kesempatan yang
sama.

Menurut Cohen, et.al, (2007, hlm. 101) “Generally speaking, the larger the

sample the better...” Dapat diartikan bahwa secara umum, semakin besar
sampel semakin baik, akan tetapi ada jumlah batas minimal yang harus diambil oleh
peneliti yaitu sebanyak 30 sampel atau lebih. Cohen menjelaskan bahwa:

Thus, a sample size of thirty is held by many to be the minimum number of

cases if researchers plan to use some form of statistical analysis on their

data, though this is a very small number and we would advise very

considerably more.
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Hal yang sama juga dikemukakan oleh Baley dalam Mahmud, (2011, him.
159) yang menyatakan bahwa “untuk penelitian yang menggunakan analisis data
statistik, ukuran sampel paling minimum adalah 30.” Selain itu, Gay dalam
Mahmud, (2011, him. 159) berpendapat bahwa:
Ukuran minimum sampel yang dapat diterima berdasarkan metode
penelitian yang digunakan, yaitu: a. Metode deskriptif, minimal 10%
populasi. Untuk populasi relatif kecil, minimal 20%; b. Metode deskriptif
korelasional, minimal 30 subjek c. Metode ex-post facto, minimal 15 subjek
per kelompok d. Metode experimental minimal 15 subjek per kelompok.”
Sedangkan menurut Roscoe dalam Sugiono, (2014, him. 91) menyarankan
tentang ukuran sampel untuk penelitian sebagai berikut:
@ Ukuran sampel yang layak dalam penelitian adalah antara 30 sampai
dengan 500. (b) Bila sampel dibagi dalam kategori maka jumlah anggota
sampel setiap kategori minimal 30. (c) Bila dalam penelitian akan
melakukan analisis dengan multivariate (korelasi atau regresi ganda
misalnya), maka jumlah anggota sampel minimal 10 kali dari jumlah
variabel yang diteliti. Misalnya variabel penelitiannya ada 5 (independen +
dependen), maka jumlah anggota sampel = 10 x 5 =50. (d) Untuk penelitian
eksperimen yang sederhana, yang menggunakan kelompok eksperimen dan
kelompok kontrol, maka jumlah anggota sampel masing-masing antara 10
s/d 20.
Dari beberapa penjelasan tentang ukuran sampel di atas, maka jumlah
sampel dalam penelitian ini adalah 30 orang siswa SMK Wikrama 1 Garut.
35 Instrumen Penelitian
Instrumen penelitian adalah semua alat yang digunakan untuk
mengumpulkan, memeriksa, menyelidiki suatu masalah, atau mengumpulkan,
mengolah, menganalisa dan menyajikan data-data secara sistematis serta
objektif dengan tujuan memecahkan suatu persoalan atau menguji hipotesis.
Dalam penelitian ini digunakan instrumen Boddy Mass Index(BMI),
International Physical Activity Quisionare (IPAQ) dan Tes Kebugaran Jasmani
Indonesia (TKJI)
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Tes Kesegaran Jasmani Indonesia (TKJI 2003:3-30). Teknik
pengambilan data yang digunakan dalam penelitian ini adalah dengan
menggunakan TKJI, terdiri dari beberapa item tes dan pengukuran yang
meliputi: 1) Tes lari cepat (sprint/dash) 60 meter; 2) Tes gantung angkat tubuh
untuk putra dan gantung siku tekuk untuk putri; 3) Tes baring duduk 60 detik;

4) Loncat tegak; dan 5) Tes lari 1200 meter untuk putra dan 1000 meter untuk
putri(PENDIDIKAN & INDONESIA, 2014).

TKJI juga membedakan beberapa jenis tes berdasarkan jenis
kelamin. Tes ini merupakan suatu rangkaian tes jadi dalam pelaksanaannya tidak
boleh terputus namun berkelanjutan dalam suatu rangkaian tes. Menurut Pedoman

Kemendiknas ( 2010 : 6 — 22 ) proses pelaksanaan TKJI adalah sebagai berikut :

Tabel 3. 2 Nilai TKJI (Untuk Putra Usia 16-19 Tahun)

Gantung Baring Loncat
Nilai | Lari 60 M | siku/angkat duduk Tegak Lari 1200 M
Tubuh

5 S.d-72" | 19— Keatas | 41 —-Keatas | 73 Keatas | s.d—3“14”
4 7.37-8,3” 14 - 18 30-40 60-72 | 3715”7 -4"25”
3 8,47 -9,67 9-13 21 -29 50-59 | 4726”5127
2 9,77 -11,0” 5-8 10-20 39-49 | 5137 —6"33”
1 11,17 dst 0-4 0-9 38 dst 6°34” dst

Tabel 3. 3 Nilai TKJI (Untuk Putri Usia 16-19 Tahun)

Gantung
. Baring Loncat
Nilai | Larigom | Skuangkat Lari 1000 M
duduk Tegak
Tubu
h
5 S.d-8,4” | 41” keatas | 28 Keatas | 50 Keatas | S.d—3“52”
4 8.57-9.8” 227 —40” 20 — 28 39-49 3.537-4" 56"
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3 9.97-11.4” 107 -21” 10-19 31-38 4577 — 558
2 11.57-13.4” 3»-9” 3-9 23-30 5%59” — 77237
1 13.5” dst. 0°-2” 0-2 22 dst 7°24” dst
Tabel 3.4 Norma Tes Kebugaran Jasmani Indonesia
(Untuk Putera dan Puteri)

No. Jumlah Nilai Klasifikasi Kesegaran Jasmani
1 22-25 Sangat Baik (SB)
2. 18 - 21 Baik (B)
3. 14— 17 Sedang (S)

4. 10-13 Kurang (K)
5. 5-9 Kurang sekali (KS)
3.6 Analisis Data

Analisis data disebut juga pengolahan data dan penafsiran data. Analisis
data merupakan rangkaian kegiatan penelaahan, pengelompokan, sistematisasi,
penafsiran dan verifikasi data. Analisis data dilakukan dengan tujuan untuk menguiji
hipotesis dalam rangka penarikan simpulan. Teknik analisis data dalam penelitian
ini terdiri dari beberapa langkah, yaitu:

3.6.1 Rata-rata dan Simpangan Baku

Untuk mepermudah penghitungan rata-rata dan simpangan baku digunakan
aplikasi Statistical Package for the Social Sciences (SPSS) versi 18. Tahapan
penghitungan yang akan dilakukan dengan langkah-langkah sebagai berikut: klik
Analyze > Descriptive Statistics > Descriptives > Masukan semua variabel ke kotak
Variable(s) > Options > ceklis Mean dan Std. Deviation > Continue > OK.

3.6.2 Uji Normalitas

Uji normalitas salah satu uji prasyarat yang digunakan untuk mengetahui
apakah data tersebut berdistribusi normal atau baik. Uji normalitas menggunakan
kolmogorov-smirnov dengan bantuan Statistical Package for the Social Sciences
(SPSS) versi 18. Tahapan penghitungan yang akan dilakukan dengan langkah
langkah sebagai berikut: klik Analyze > Nonparametric Tests > Legacy Dialogs >
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1-Sample K-S > Masukan semua variabel ke kotak Test Variable List > OK. Format
pengujiannya dengan membandingkan nilai probabilitas (p) atau signifikansi (Sig.)
dengan derajat kebebasan (dk) a = 0,05. Uji kebermaknaannya sebagai berikut:

1) Jika nilai Sig. atau P-value > 0,05 maka data dinyatakan normal.

2) Jika nilai Sig. atau P-value < 0,05 maka data dinyatakan tidak normal.
3.6.3 Uji Homogenitas

Uji homogenitas digunakan untuk mengetahui apakah suatu data atau

sampel yang diambil berasal dari varian yang homogen atau tidak. Uji homogenitas
dilakukan sebagai prasyarat dalam uji anova. Uji homogenitas menggunakan
Lavene Statistic dengan bantuan Statistical Package for the Social Sciences (SPSS)
versi 18. Tahapan penghitungan yang akan dilakukan dengan langkah-langkah
sebagai berikut: klik Analyze > Compare Means > One-Way ANOVA > Masukan
variabel ke kotak Dependent List > Masukan faktor ke kotak Factor > Options >
Homogenity of variance test > Continue > OK. Format pengujiannya dengan
membandingkan nilai probabilitas (p) atau signifikansi (Sig.) dengan derajat
kebebasan (dk) o= 0,05. Uji kebermaknaannya sebagai berikut:

1) Jika nilai Sig. atau P-value > 0,05 maka data dinyatakan homogen.

2) Jika nilai Sig. atau P-value < 0,05 maka data dinyatakan tidak homogen.
3.6.4 Uji Hipotesis

Uji hipotesis yang digunakan dalam penelitian ini menggunakan uji korelasi

dengan bantuan Statistical Package for the Social Sciences (SPSS) versi 18. Uji
kebermaknaannya sebagai berikut: 1. Terdapat hubungan antara jenis kelamin
dengan kebugaran jasmani apabila nilai signifikansi (Sig.) < 0,05 yang berarti
signifikan dan hipotesis diterima. 2. Terdapat hubungan antara status gizi dengan
kebugaran jasmani apabila nilai signifikansi (Sig.) < 0,05 yang berarti signifikan
dan hipotesis diterima. 3. Terdapat hubungan antara aktifitas fisik dengan
kebugaran jasmani apabila nilai signifikansi (Sig.) < 0,05 yang berarti signifikan
dan hipotesis diterima. 4. Terdapat hubungan antara jenis kelamin, status gizi, dan
aktifitas fisik dengan kebugaran jasmani apabila nilai signifikansi (Sig.) < 0,05

yang berarti signifikan dan hipotesis diterima.
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